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IMPORTANT SAFETY INSTRUCTIONS

When using electrical products, basic precautions should always be followed. Please refer below:
1. Read Instructions - All safety and operating instructions should be read before operated.

2. Retain Instructions - Safety and operating instructions should be retained for future reference.

3. Follow Warnings - All warnings on the product and in the manual should be adhered to.

4. Follow Instructions - All operating and user instructions should be followed.

5. Cleaning - Unplug this product from the wall outlet before cleaning. Do not use liquid or
aerosol cleaners instead use a damp cloth for cleaning.

6. Attachments - Do not use attachments not recommended by the product manufacturer as they
may cause hazards.

7. Water and Moisture - Avoid exposing the product to water and moisture.

8. Accessories - Securely place this unit before use. The product may fall if not properly placed
causing serious injury to child or adult and may damage the product. Use only with a stand,
bracket, or table recommended by the manufacturer If the product needs to be mounted, you
should follow the manufacturer's instructions and should use a mounting accessory recommended
by them.

9. Transporting - This product should be moved with care to avoid
damage or injury.

10. Ventilation - Slots and openings in the cabinet are provided for
ventilation. This is to ensure reliable operation of the product and to
protect it from overheating. Openings must not be blocked or covered.
This product should not be placed in a built-in installation such as a
bookcase or rack unless proper ventilation is provided or the
manufacturer's instructions have been adhered to.

11. Power Sources - This product should be operated only from the
type of power source indicated on the marking label. If you are not /- =

sure of the type of power supply to your home, consult your product —#
dealer or local power company. For products intended to operate from

battery power, or other sources, refer to the instruction manual.

12. Power-Cord Protection - Power-supply cords should be properly secured so that they are not
likely to be entangled in any way.

13. Lightning - For added protection for this product during a lightning storm, or when it is left
unattended for long periods of time, unplug it from the wall outlet and disconnect the antenna or
cable system. This will prevent damage to the product due to lightning and power-line surges.

14. Overloading - Do not overloads wall outlets and extension cords, as this can result in a risk of
fire or electric shock.

15. Object and Liquid Entry - Never push objects of any kind into this product through openings

as they may touch dangerous voltage points or short-out parts that could result in a fire or electric
shock.

16. Servicing - Do not attempt to repair this product yourself as opening or removing covers may
expose you to dangerous voltage or other hazards. Refer all servicing to qualified service
personnel.

17. Damage Requiring Service - Unplug this product from the wall outlet and refer servicing to
qualified service personnel under the following conditions:

a. If the power-supply cord or plug is damaged.

b. If liquid or objects have fallen into the product.

c. If the product has been exposed to rain or water.

d. If the product does not operate and you have followed the manual for troubleshooting.

e. If the product has been dropped or damaged in any way, and the product exhibits a distinct
change in performance may indicate a need for service and/or repair.

18. Replacement Parts - If a part needs to be replaced, be sure the service technician has used
replacement parts specified by the manufacturer or have the same characteristics as the original
part. Unauthorized substitutions may result in fire, electric shock, or other hazards.

19. Safety Check - Upon completion of any service or repairs to this product, ask the service
technician to perform safety checks to determine that the product is in proper operating condition.

20. Wall or Ceiling Mounting-The product should be mounted to a wall or ceiling only as
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recommended by the manufacturer.
21. Heat-The product should be situated away from heat sources such as radiators, heat registers,
stoves or other products (including amplifiers) that produce heat.

PRECAUTIONS

1. In order to shut off the unit completely, unplug the power cord from the wall outlet, be sure to
unplug the unit if you do not intend to use it for a long period of time.

2. Incorrect use of controls, adjustments and performance other than those specified herein may
result in hazardous radiation exposure.

3. Should this product malfunction, discontinue use and contact a qualified service center.

WARNING
To reduce the risk of fire or electric shock, do not expose this appliance to rain or moisture.

CAUTION
RISKS OF ELECTRIC SHOCK- DO NOT OPEN!
To reduce the risk of electric shock, do not remove casing.
No user serviceable parts inside. Refer servicing to qualified service personnel.

The light flash with arrowhead symbol, within an equilateral triangle, is intended to
alert User to the presence of “dangerous voltage” which may be of sufficient
magnitude to cause electric shock to persons.

The exclamation point inside an equilateral triangle is intended to alert
User to the
presence of important operating and maintenance (servicing) instructions in the
literature that may accompany the appliance.

This product may contain cheimcals listed in Proposition 65
(http://www.oehha.ca.gov/prop65/prop65_list/Newlist.html)
That may be known to cause cancer, birth defects or other reproductive harm

CAUTION: To prevent shock, match wide blade of plug to wide slot, fully inserted
BEFORE USE

1. Choose a safe location and avoid placing the unit in direct sunlight or near any heat source.

2. Avoid locations subject to vibrations, excessive dust, cold or moisture.

3. Do not open the cabinet as this may result in electrical shock. If a foreign object is inserted
accidentally contact your dealer.

4.  When removing the power plug from the wall outlet, pull directly on the plug, NOT the cord.

5. Do not attempt to clean the unit with chemical solvents as this might damage the finishing. A
clean, dry cloth is recommended for cleaning.

6. In order to completely turn off the unit, unplug the power cord from the wall outlet.

7. Keep this manual for future reference.

TURNTABLE PARTS

1. Dust Cover

2. Platter

3. 45 rpm Adapter
4. Tone Arm

5. Lift Lever

6. Speed Selection

7. Auto Stop Control
8. Tone Arm Rest

9. USB Jack

10. RCA Qutput




11. AC Power Cord
12. Turntable Feet
13. Style (Needle) Cartridge

LISTENING to a RECORD

Raise the dust cover _
Connect the AC power cord 11 to an electrical outlet (120V~60Hz)

Use a RCA cable to connect unit’s RCA output 10 with your powered speaker. Make sure
the red RCA and white cables are inserted in the red and white jacks accordingly.

Place a record on the turntable and select the player speed (33/45/78) 6 according to the
desired record speed. NOTE: when playing a 45 rpm record, use the 45 rpm adapter _.
Remove the tone arm from the rest 8, push Lift Lever backward 5 to raise the tone arm
and gently move the tone arm to the desired position over the record. The turntable will begin
to spin when the arm is moved toward the record. Push the Lift Lever 5 forward lower the
tone arm slowly onto the desired position on the record to begin playing_the record.

If Auto Stop Control 7 is turned ON, record will stop automatically when finished.

If Auto Stop Control 7 is turned OFF, record will NOT stop automatically when finished.
For best performance and product maintenance, unplug the Turntable when not in use.

HOW to REPLACE the TURNTABLE STYLUS (NEEDLE)
To replace the turntable stylus (needle), please refer on the instructions below:

REMOVING the STYLUS from the CARTRIDGE

1.
2.

Place a screwdriver at the tip of the stylus and push downward as shown in direction “A”.
Remove the stylus by pulling the stylus forward and pushing downward.

INSTALLING the STYLUS (NEEDLE)

1.
2.

Hold the tip of the stylus and insert the stylus by pressing as shown in direction “B”.
Push the stylus upward as in direction "C" until the stylus locks into the tip position.

o\l

0 o
RECORD uide i (nsiee YOUR

VINYL TO PC in WINDOWS
SYSTEM

SOFTWARE INTRODUCTION

Audacity application software is included with your Vinylwriter and is designed to record and
save music from the photograph to a computer. The software then allows for the same recorded
files to be converted and edited to .WAV and/or .MP3 file formats. The recorded music can then
be played using Windows Media Player and other applications that support WAV and .MP3
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formats.

SOFTWARE INSTALLATION and USB CONNECTION

To install the Audacity software in your computer, please follow the instructions below.
1. Insert the Audacity software (included) into your computer's disc tray.

The Audacity Setup Wizard will appear. Click on "Next" to install the software.

i Setup - Audacity E::@

Welcome to the Audacity Setup
Wizard

Thas will install Audacity 1,26 on your computber

It is recommended that vou cloze all athes applications before
conhinung.

Click Mest to continwe, or Cancel bo st Setup.

[ Mest > J[ Cancel

2. Select “I accept the agreement” and click on Next
i Setup - Audacity

License Agreement
Pleas= read the tolowing impartant information before conbinuing.

Pleazs read the folowing Licenss Agreement. You must acoept the temms of this
agreement before continuing with the installabon.

Mote: Sudacity iz distributed under the terms of tha GHU GPL. ~
T hiz includes eveything in the source code distribution

except code i the lib-sre drectory, Code i the lib-src

directony may be released under a diferent license

[which iz GPL-compatible]. For a summary, s2e the

README. bt file, and for specific detads, see the icanse

Infarmation inside each subdiectory of lib-src.

The iull text of the GHU GPL follows:

GNU GEMERAL FUBLIC LICEMSE b

%) | accept the ageement
(11 do not aceepl the ageement

| <Back || MNews | | Cancel




3. Continue to click on the "Next" button until the software installation begins.
1& Setup - Audacity

Information |H ]
Please read the followirg important informabion befoe continung.

W'hen vou are ready o continue with Setup. clck: Mext.

busdacity: & Free, Cross-Platform Digtal Audio E ditor

Version 1,26 T
Fior changahon, zee e bottorn of the document,

It hittocs S audacity sourcaforgs, net!

Email audacity-help@izts soucsfoge. net

Lead D evelopers;

Dominic b azzoni (project leader)

B alt Bruoechk

James Crook
Waughan Jehnoon

l < Back ][, el = _i[ Carcel I

i Setup - Audacity

Select Destination Location ﬁ )
Where zhould Audacity be inztalled?

’_‘j Setup will inztall Audacity into the following folder,

Ta contirue, click Mest, IF pau would like o select a differant falder, click Browse,

= |

: '-.f I -.'|r|'| ||;- -'

Saudacity

At leazt 8.3 MB of free dizk zpace iz required.

[ < Back ” Mext » l[ Cancel




i Setup - Audacity

Select Additional Tasks
‘Which additional tasks should be performed?

clhick Mext

Addsonal icons:

Create a deskiop icon

Other tasks:

Azzociate Audacity project files

Select the additional tazks wou would like Setup to perfom whils instaling Audaciby, then

cBack || Mew> || Cancel

4. Click on the "Install" button to start the Audacity software installation.

15 Setup - Audacily

Ready to Install
Setup s now ready to begin instaling Audacty on vour computer.

change any settings.

| Diestination location:
| CA\Program Files\audacity

| Additional tasks:
Addstonal icons:

Create a dasklop icon
Olther tazks:

Azzociate Audacity project files

Click Inztall to continue with the inztalation. or click Back if you want o review of

< Back “ Install

J |

Cancel ]




i Setup - Audacity

Inztalling
Plaase wail while Setup inatalls Sudaoity on you conmputes.

Estracting file=.,
C:\Progearm FilezhAudacinhl snquagesukAudacity. mo

|“ Cancel

5. Click on "Finish" to complete installation.
12 Setup - Audecity BI: sl

Completing the Audacity Setup
wizard

Sebp hat Aniched mstallrg Audacky on wour computer T he
applicabon may be launckad by selechng the retaled icons

Cick Finizh o exit S=hyp

[¥] Launchdudaciy

| Fnizh

6. You can now open the Audacity software and start recording your files.
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RECORDING OPERATION STEPS

1. Connect the USB cable to your turntable and your computer. No extra driver is required to

drive the USB.
2. Power and play your record by lifting the tone arm towards the platter.

3. Double click the Audacity program and you will see this interface screen on your computer.

Pis EH Ve Promct Gewrate ffiect fndree Feb

[ —
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7 D B @ Nemshers =
-'fl"' iu'l“l “""“ti ﬁi»‘lﬁﬂ

vun 40100 | Corver DEGORBD B0 NiaacTe GA1

4. Adjust the output and input volume.
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-l

_l o - ? - . * 1Et.| it ﬂ

Glwrem

[xmmwa] o] 2200
§ 20

fotw | o plin e Y idshs

L ) ) _
5. Select the RECORD button to start recording.

A DIGOPL

"

o
6. Select the to skip to start.

W
7. Select the _/ button to go to end.

n

8. Select the PAUSE button to pause the recording.

=
9. Select the STOP button to stop the recording.

10. You can see the recorded file on your computer and convert the recorded file to other formats
including .WAV and MP3.
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11. Play the saved file.

>)
Put the saved file in the Audacity program and press the PLAY button to play the file.

CONVERTING RECORDED FILES to .WAV and .MP3 FILE FORMATS

Please make sure that you have properly connected the Vinylwriter USB to your computer and
follow the instructions below to convert your files to “.wav and .mp3” file formats

1. Make sure that the Audacity installation disc is still inserted in your computer. Go to your
Desktop and double click on the "My Computer™ icon.

2. Locate the CD ROM Drive and double click on the icon.

3. Copy the lame_enc.dll file and paste it to your Desktop.
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Fe Edit ‘Wiews Favortes Tools Help

@Eatk - 'k.j |J; pieard'n [~ Folders | [77]~

A
File and Folder Tasks B ﬁam
M| Rename this file
[ Move this file
L n e cec.oi

&N Pubish this file to the
Web

{3 E mal this file
¢ Delebe this file

Other Places

i My Computer

(£} My Documents
[Cy Shared Documenks
W iy Network Places

— AUTCRLN
= Sstup InFormakion

Audacity Setup = 1tE

HINOD3Z antivieus system

Open With...

B ndd to archive...

B hdd to “lame_snc.rar®

E Compress and email...

B Compress to "lame_snc.rar” and emal
E-mall with Yahoo!

Send To ]

Cuk

Create Sharkeut
Delete

Bl
i

4. After copying the file, open the Audacity Software. Click on the "RECORD" Button to start the
recording process. Make sure that a vinyl record is playing on the turntable and the USB cable is

connected to the turntable and your computer.

5. You may press the Stop Button at any desired time. Once you have the recorded file that will be
converted, press the "Edit" tab and select "Preferences"

= Audacity

=13

[Dmk space remains for recording 74 hours el 35 rinutes
Project refe: 44100 | |Cursor 0:00 000000 min:sec ISmpIoOﬁ]

6. Locate "File Format" tab and click on the "Find Library" button

13



Audaciiy Preferences

Audio 1/0 | Quality  File Formats ] Spectrograms | Divectaries | |nterface | Keyboard | Mouse |

i When mporting uncompressed audio files into Audacity
" Mace a copy of the file before editing [zafer)
[ * Read directly fram the onginal file [faszter)

i~ Uncomoressed E xport Fomat
|\l Microsoft 16 bit PCM) |
I WA [Mizrozaft), Sigred 16 bit PCH

~ DGG Epart Setup
OGG Qualty: | 5 0 ¥ 10
i MP3 Expart Setup
MP3 Liorary Werzion:  MP3 exporting plugin not found Fird Libeasy | )

Bit Rate: |'_-: b

= Audacil Audacity Preferences

fuda 10 | Qusily Fie Fomats | Spectiograms | Diectories | Inteface | Keybosd | Mouse |

. = - When importing uncompressed audio fles into Awdacity
| ™ Make 2 copy of the file befare adkng [zaler)
| 1 Read drecily from the original file [faste]

Urneompeestad Expail Faimat

freely available LAME ibrary bo hande MPS file encading. You must s
obkain bame_enc.dl separately, by downloading the LAME MP3 encodes, and then locate this file For fudacity. You
only nead to do this ance.,

6.0
‘:, Budacity dess not expark MP3 files directly, but instead uses the

Wetould vou Bl ko locate lame_enc,dll now?

I Yes I I
Bit Fiate: 124 'i

Digk Spacsr|

Project rele: Cancel 114

7. Click ™Yes" button, then go to your Desktop and highlight the lame_enc.dll.
Next, click on the "Open™ button.
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Where is lame_enc.dll?

Look inc | [ Desktop x| &« @ e
. i|:'|l'~'h|r Documents
'.3‘ ¢ My Computer

My Recent |\ Widmy Metwork Places
B |C)Boss Yideos

T =
! (5 — >
iy Documsnts {)

My Computer

A
File name: [lane_enc - < Open |
by Metwork.  Files of tupe: Ill‘ll_l,l lame_enc.dl ﬂ el
Fiaces ™ Open az readorly
S

8. Click on the "OK" button and return to the default window of the Audacity Software.

Audacity Preferences

Audio 1/0 | Qualty  File Formats i Spectrograms | Diectories | Interface | Keyboard | Mouss |

- When mpodteg ecomprazsed aiidio files inba Sosdeciy

™ Make s copy of the fils bafore editing [safer)
* Read diectly from the ariginal file [faster)

- Uncompressed Export Format
[WAV Microsolt 16 bt PCM] |

e [Microsoft). Signed 16 bit PCM

0GGE Expot Sefup
OGGQualy: | 5 0 | 10

MP3 Export Setup

Eit Rate: 128 v}

MP3 Libram Yersion: LAME +3.95 Find Library

Cancel |( OK D
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9. Click on the "File" tab and the option will be given to export the recorded file as “.wav”,

“.mp3” or “.0gg” file formats.

= Audacity l..._”E'[il
a8 Edic ¥ew Projett Generate  Effect  Analyee  Help

Mew Chrl+

Open... Chrl n [ i

Closa PR b B R

Save Project Chrl+s ¥ I—L|

Zave Project As. . m—

Recent Files.,, ] E'lﬁ’& EI.

2.0

Export Bs Ogg Yorbis...

Export Labals

Export Multiple...

Page Setup...
Brint....

Exit

| Disk =pace remains for recording 74 hours snd 34 ninues

Projecipster 44100 | Cursor .00 000000 mircsee [Snep-To O11]

S

10. Once you have selected the desired file format to export your recorded music, enter the file
name and location where you want to save the file on your computer. Once finished, click on the

"Save" button.

Save MP3 File As:

Save i l[_@ Desklop
e f_]l'-'l':.-' Docurnents
@ ' My Computer

MyRecent  Jpby Network Places
JotUme _ljBass Videos
1DAE_photo
ChPaul Pics 2
_Pual Folders

A test_data

‘—] Cvisa

. afyserver

My Documents ®)tests

kdy Computer

<

My Metwork  File narne:
Places

Save as lype;

11. Enter the title, artist and any other information about the MP3 file that you have created and

click on the "OK" button.
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Edit the ID3 tags for the MP3 file @

Frarnat;
1031 [more compatible]
D32 [more flewble)

Title: | Test1

Artigt: |Madonna

Adburr; |Hung Up

Track Mumber Year

Gerine: | Bluss :]

Comrreris: |mlﬂ

Cancel | 0k I

12. Next, go to the location of the file you have converted. You can play the converted file on any
application that supports .WAV or MP3 formats.

© Windows Media Player =113

Filz View Floy Took Heolp

[<] hiow Playing v _0OX
Madiornna Find Albwm info

Now

meg L3 TEStl

Media
Guide

-
Copy from
uy]

Media Hung L
Libwary -

Radio
Tuner

Copy bo Ch
or Device

Prremium
Services
Skin
Chooser

Tokal Time: 0:09

(N OMOOMIN==2® oo
NOTE: Converted files can be transferred (burned) to a CD. Please refer to the manufacturer's
instructions provided with your CD burner or computer for additional details.

RECORD YOUR VINYL to PC using a MAC

1. Plug your Vinylwriter’s power cord into a power outlet.

2. Connect your Vinylwriter to your MAC using the supplied USB cable.
3. Press the power button on your Vinylwriter.
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4. Open “System Preferences” on your MAC: Applications > System Preferences
5. Under ‘Hardware’ click on *Sound’ (icon of speaker)

e C)f7 System Preferences

4| > Show All

Personal
Appearance Desktop & Dack Exposé & International Security Spotlight
Screen Saver Spaces
Hardware
0 & m [ o wm (A
¥ O .
Bluetooth CDs & DVDs Displays Energy Keyboard &  Print & Fax Sound
Saver Mouse

Internet & Network
PN PN PN .
6. Select ‘Input’ and choose the AK5371 USB device.

[ Sound Effects  Output | Input |

Choose a device for sound input

"Name iType [
Line In Audio line-in port

Digital In Optical digital-in port

AK5371 USB

Settings for the selected device:

7. Close the System Preferences window.

8. Ensure the Audacity Software has been downloaded and installed to your computer.
Audacity can be downloaded here: http://audacity.sourceforge.net/download/mac

9. Launch Audacity Software from the saved location (commonly saved under ‘Applications’)

10. Open Preferences for the Audacity Software under the Audacity Menu.
8 WLYTETEE File Edit View Project Generate Effect Analyze Help

-

Preferences €,

L
:R|

;34»).3 48 -4z -36 -30 -24 -18 -12 -6 O )E

e @ i DefanhinputSnuﬂ:zuﬁ J %%‘M‘M’lﬂ' | e pﬂ,@
4.0 5.0 7.0 8

Services

Hide Audacity %H 8
Hide Others "C3H
Show All

Quit Audacity  #Q

11. Refer to the ‘Audio 1/0O tab’ and under ‘Recording’ select AK5371 and press ‘OK’.

18



| Audio 1/O | Quality  File Formats  Spectrograms  Directories  Interface  Keyboard Mouse}—

Playback

Device: | Built-in Output 3|

_Recordin  gyjit-in Line Input
Built-in Digital Input

[ 2 (Stereo)

D Play other tracks while recording new one
=

12. Press the RECORD button in the Audacity Software (NOTE: recordings will begin as soon as
you release the RECORDING button). Position the needle on your vinyl record where you would
like the recording to begin.

z — — = 4 B
S
é : 1)
*. | Default Input Source &
-1.0 0,0 1.0 2.0 3.0 4.0

13. Press the STOP button when you would like the recording to end.

O
=" L .
ML L

: =, ﬁ — — y r =
. a | ¥ | ! { |
Pex [ osgs" ) 48 42 36 30 24 -18 -12 6 0 Pz 48 42

BN = — e )'@ o] 1Defauklnput5¢urce§§ﬁ§"“l'ullu}{n 3 ﬁﬁ&&
13.0 14.0 15.0 16.0 17.0 18.0 19.0 20.0 21.0 22.0 2

| xX[Audio Trac ¥ [ 1.0

Stereo, 44100H3 0.5
32-bit float .

Mute | Solo | 0.0
|.I R 0.5
g R0
1.0
0.5

0.0

-0.5
-1.0

14. You can edit your recorded track(s) using the Audacity features.
15. You can save your recordings as various file types under the File Menu.

TIPS for BETTER TURNTABLE PERFORMANCE

1. When opening or closing the turntable cover, handle it gently, moving it either at the
center or equally from both sides.

2. Do not touch the stylus (needle) tip with your fingers; avoid bumping the stylus on the
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turntable or record’s edge

3. Clean the stylus tip frequently - use a soft brush in a ‘back-to-front” motion only.

4. If you must use a stylus cleaning fluid, use very sparingly.

5. Wipe the dust cover and turntable housing gently with a soft cloth. Use only a small
amount of mild detergent solution to clean the turntable and dust cover.

6. Never apply harsh chemicals or solvents to any part of the turntable system.

7. Always unplug the unit from the AC outlet and secure the tone arm before moving

el

SPECIFICATIONS:

Power Requirements:
Power Consumption:

Motor:

Drive System:
Speeds:

S/N Ratio:

Tone Arm:

Cartridge/ Stylus (Needle):

Base & Platter:

Dimensions (LXDxH):
Weight:

Accessories:

AC 120V~50Hz
8w

EG-530SD-3F
Belt

33-1/3, 45, 78 rpm
35dB

Straight Plastic & Aluminum
Ceramic Stereo/ Jewel Stylus
MDF Cabinet Base, Plastic Core & Platter

10.7 x 13.1 x 4.0 inches (approx.)
4.5 Ibs (approx.)

User Guide, 45rpm Adapter, USB & RCA Cords, Audacity Software

CUSTOMER SERVICE & SUPPORT

Should you have any questions regarding your Vinylwriter please

visit us at www.gracedigitalaudio.com or
send us an email to info@gracedigital.net or

call Toll-Free 866-446-0961

Our Customer Service hours are scheduled for

Monday to Friday 8:30AM to 5:00PM Pacific Standard Time
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Thank you for your purchase with Grace Digital Audio. All Grace
Digital Audio products purchased in the United States of America
are supported by a conditional warranty.

WARRANTY

This itern is guaranteed by Grace Digital Inc. Tor a pericd af 1 year fram the
original date of purchase.

This guarantee covers the replacernent af equipment that proves 1o be faulty
as a result of manufacturing faults only. Na hability can be accepted Tar faults
arising from accident or misuse.

I the event your equiprment reguires warranty attention andor service,
please contact Grace Digital Inc. at [S66] 446 - 0961 or al their websile
wannl gracedigitalaudio.com.

I the event a replacement s required and there is a shartage of stock, Grace
Cigital Inc. reserves the right to replace faulty iterms with similar eguiprment
of eguialent value.

CONDITIONS

1. This Warranty will be granted when the ariginal invaice ar sales receipt
fwith proof of date of purchase, product type and dealers name) is
presented together with the defective product.

2. This guarantee will not reimburse nor cover the darmage resulting fram
adaptations or adjustments which may be made ta the product.

3. This guarantee will not include any o some af the Tallowing:
I. Maintenance andfor repair of parts due 1o normal wear and tear.

i. Changes to the product frem it normal purpose as descnbed in the
irstruction manual,

ii. Trarsporiation costs, home service casts and all related risks and costs
of transport.

4. Damage resulting from any of the fallowing:

I Misuse including using for a purpose other thar intended, installation
ar use of the product in & manner inconsistent with the technical or
safety standards, improper or incorect installation.

i. Repair done by non-authorized establishiment or individual.

li. Accidenits including lightening, water, fire, improper ventilation ar any
cause beyend the control of Grace Digital Inc.

Grace Digital Inc. is an exclusive dstribular o Grace Digital Audio Products, San Diego, CA
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Grace Digital Audio
San Diego, CA 92129
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